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Before you Begin

Who Should Use this Manual
This manual is for system administrators responsible for installing, configuring,
deploying, and maintaining Citrix ICA Clients for Macintosh (also called the
Citrix ICA Macintosh Client). This manual assumes knowledge of:

“ Citrix MetaFrame or Citrix WINFRAME

“ The operating system on the client computer (MacOS)
“ Installation, operation, and maintenance of network and asynchronous

communication hardware, including serial ports, modems, and device adapters

How to Use this Guide
To get the most out of the Citrix ICA Client Administrator’s Guide, review the
table of contents to familiarize yourself with the topics discussed.

This guide contains the following sections:

Chapter Contents

Chapter 1, “Introduction to the
Citrix ICA Macintosh Client”

Gives a detailed list of features.

Chapter 2, “Deploying the Citrix
ICA Macintosh Client”

Describes how to install and deploy the Citrix ICA
Macintosh Client.

Chapter 3, “Configuring the Citrix
ICA Macintosh Client”

Describes how to configure connection properties
and device mappings for the Citrix ICA Macintosh
Client.
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Conventions
The following conventional terms, text formats, and symbols are used throughout
the printed documentation:

Convention Meaning

Bold Indicates boxes and buttons, column headings, command-line
commands and options, icons, dialog box titles, lists, menu names,
tabs, and menu commands.

Italic Indicates a placeholder for information or parameters that you
must provide. For example, if the procedure asks you to type
filename, you must type the actual name of a file. Italic also
indicates new terms and the titles of other books.

ALL UPPERCASE Represents keyboard keys (for example, CTRL, ENTER, F2).
[brackets] Encloses optional items in syntax statements. For example,

[password] indicates that you can choose to type a password with
the command. Type only the information within the brackets, not
the brackets themselves.

...(ellipsis) Indicates a command element can be repeated.
Monospace Represents examples of screen text or entries that you can type at

the command line or initialization files.
ù Indicates a procedure with sequential steps.
• Indicates a procedure with only one step.
“ Indicates a list of related information, not procedural steps.

The Citrix ICA Client for Macintosh allows users to connect to MetaFrame and
WINFRAME servers. When describing a feature or procedure common to
MetaFrame and WINFRAME servers, this manual uses the term Citrix server. When
describing a feature unique to a MetaFrame or WINFRAMEWINFRAME server, this
manual specifies either a MetaFrame or WINFRAME server.
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Finding More Information
This manual contains conceptual information and installation and configuration
steps for the Citrix ICA Macintosh Client. For additional information, consult the
following manuals:

“ The Citrix ICA Client Quick Reference Cards give users step-by-step
instructions for using the Citrix ICA Clients to connect to Citrix servers and
run published applications.

“ The Citrix ICA Client Administrator’s Guides for the ICA DOS, Win16,
Win32, Java, Web, and UNIX Clients.

“ For instructions on installing, configuring, and maintaining your Citrix servers,
see the documentation included in your MetaFrame or WINFRAME package.

This book and other Citrix documentation is available in Adobe PDF format in the
documentation directory of your MetaFrame or WINFRAME CD-ROM. Using the
Adobe Acrobat Reader, you can view and search the documentation electronically
or print it for easy reference. To download the Adobe Acrobat Reader for free,
please go to Adobe’s Web site at http:\\www.adobe.com.

Always consult the Readme.txt files for MetaFrame, WINFRAME, and
the Citrix ICA Clients for any last-minute updates, installation instructions, and
corrections to the documentation.

Citrix on the World Wide Web
Citrix offers online Technical Support Services at http://www.citrix.com that
include the following:

“ Downloadable Citrix ICA Clients, available at http://download.citrix.com
“ A Frequently Asked Questions page with answers to the most common

technical issues
“ An FTP server containing the latest service packs and hotfixes for download
“ An Online Knowledge Base containing an extensive collection of technical

articles, troubleshooting tips, and white papers
“ Interactive online support forums

Year 2000 Readiness
For a detailed description of the Year 2000 Readiness of Citrix products, see our
Web site at http://www.citrix.com/misc/y2000.htm.

Important
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C H A P T E R  1

Overview
When connected to a Citrix server, the Citrix ICA Macintosh Client provides
additional features that make remote computing just like running applications on a
local desktop. The Citrix ICA Macintosh Client has the following features:

“ Client device mapping
“ Client drive mapping
“ Client printer mapping
“ Client COM port mapping

“ Sound support
“ Encryption
“ Client Auto Update
“ Local clipboard integration
“ Low bandwidth requirements
“ Disk caching and data compression
“ Published application support
“ Business recovery support
“ PC key mapping

Introduction to the Citrix ICA
Macintosh Client
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Client Device Mapping
The Citrix ICA Macintosh Client supports client device mapping. Client device
mapping allows a remote application running on the Citrix server to access
printers and drives attached to the local client computer.

Client Drive Mapping
Client drive mapping allows you to access the local disk drives of the client
computer from ICA sessions. When both the Citrix server and ICA Client are
configured to allow client drive mapping, you can access your locally stored files,
work with them from ICA sessions, and then save them either on a local drive or
on a drive on the Citrix server.

Client Printer Mapping
Client printer mapping lets users access printers attached to the client computer
from applications running in an ICA session. When a Citrix server is configured to
allow client printer mapping, applications running remotely on the Citrix server
can print to local printers. With the ICA Macintosh Client, you can print to a
PostScript printer or to a PC printer connected to the Macintosh serial port.

Client COM Port Mapping
Client COM port mapping is similar to printer and drive mapping. It allows users
to access serial devices on the client computer as if they were connected to the
Citrix server.

Sound Support
ICA Client sound support allows a client computer to play sound files on the
server and hear them through the client computer's sound system. Client
computers can play 8- or 16-bit mono or stereo  .wav files at 8, 11.025, 22.05, and
44.1 KHz. Audio support can be configured to use one of three different sound
compression schemes. Each scheme provides different sound quality and
bandwidth usage.

Encryption
The Citrix ICA Macintosh Client supports basic encryption.
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Client Auto Update
The Client Auto Update feature allows administrators to update ICA Client
installations from a central location instead of having to manually install new
versions of the ICA Client on each client computer. New versions of Citrix ICA
Clients are stored in a central Client Update Database. The latest versions of the
ICA Client are downloaded to ICA Client devices when users connect to a Citrix
server.

ICA Client Auto Update supports the following features:

“ Automatically detects older client files
“ Transparently copies new files over any ICA connection
“ Provides full administrative control of client update options for each client
“ Updates clients from a single database on a network share point
“ Safely restores older client versions when needed

Local Clipboard Integration
The ICA Client allows you to cut and paste text and graphics between Windows
applications in the ICA session window and any other Macintosh application.
Access to the local clipboard requires no special configuration or procedures;
using the familiar cut, copy, and paste commands, you can transfer text, pictures,
and other objects back and forth between local and remote applications.

Low Bandwidth Requirements
The highly efficient Citrix ICA protocol typically uses 20K of bandwidth for each
session.

Disk Caching and Data Compression
These features can increase performance over low speed asynchronous and WAN
connections. Disk caching stores commonly used portions of your screen (such as
icons and bitmaps) locally, increasing performance by avoiding retransmission of
locally cached data. Data compression reduces the amount of data sent over the
communications link to the client computer.
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Published Application Support
You can create a remote application entry to connect to a Citrix server or to a
published application that contains all of the information necessary to launch a
user session or an application. All the user needs to do is double-click on the
application entry's icon on the desktop.

Business Recovery Support
The Citrix ICA Client includes the additional intelligence to support multiple
server sites (such as a primary and hot backup) with different addresses for the
same published application name.

This feature provides for consistent conections to published applications in the
event of a primary server disruption. Users now have an even higher level of fault
tolerance and seamless user experience.

PC Key Mapping
Your Macintosh mouse and keyboard can be used with the ICA session in the
usual way. Special key combinations are provided to enable users to enter PC keys
not available on standard Macintosh keyboards.

Use the following special key combinations to enter PC keys not available on a
standard Macintosh keyboard:

PC Key ICA Macintosh Client Equivalent

ALT Command (also known as the Apple key)
Insert 0 (Zero on the numeric keypad; NUM

LOCK must be off.)
Mouse right-click = key on numeric keypad or Option and

mouse click
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Overview
This chapter explains how to install the Citrix ICA Macintosh Client. Topics
covered in this chapter include:

“ System requirements
“ Installing the ICA Macintosh Client

System Requirements
Systems running the ICA Macintosh Client require the following:

“ Macintosh processor: 68030/040 or PowerPC
“ Operating system: System 7.1 or later

To run the ICA Macintosh Client on System 7.1, the Thread Manager system
extension must be installed. Thread Manager is available from Apple’s Web
site.

“ 4MB of available memory
“ 2MB of free disk space
“ 16 or 256 color video display
“ Open Transport TCP/IP Version 1.1 or later
“ A network interface card (NIC) for network connections to Citrix servers

— or —
A modem and PPP networking software for serial connections to Citrix servers

Deploying the Citrix ICA Macintosh
Client
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Installing the ICA Macintosh Client
ùùùù To install the ICA Macintosh Client

If you are installing the ICA Macintosh Client from a downloaded .hqx file, begin
with Step 4.
1. Insert the Citrix server CD-ROM in the client system’s CD-ROM drive.

Double-click the CD-ROM icon on your desktop.
2. Double-click ICACLNT and then double-click ICAMAC.
3. Copy the file MACICA_SEA.HQX to a temporary folder on the Macintosh

hard disk.
4. Decompress MACICA_SEA.HQX using the appropriate utility.
5. Open the Citrix ICA Client 4.1 folder created by the decompression utility.
6. Double-click the Installer icon to run the installation program.
7. Follow the directions on your screen.

The Client Update Database
If the version of the ICA Client currently installed supports client auto update,
future versions of the ICA Client can be automatically downloaded when a user
connects to a Citrix server. The new versions of the ICA Clients are downloaded
from the Client Update Database.

ICA Client Auto Update works with all transport types supported by ICA
(TCP/IP, IPX, NetBIOS, and serial) and supports the following features:

“ Automatically detects older client files
“ Provides full administrative control of client update options for each client
“ Updates clients from a single database on a network share point
“ Safely restores older client versions when needed

Client Auto Update can update client files to newer versions of the same
product and model. For example, it can be used to update the Citrix ICA Win32
Client. It cannot be used to update a Citrix ICA Win16 Client to the Citrix ICA
Win32 Client.

Note



Chapter 2    Deploying the Citrix ICA Macintosh Client  7

The Citrix ICA Client Update Process
Each Citrix ICA Client has a product number, model number, and version
number. The ICA Client product and model numbers uniquely identify the Citrix
ICA Client.

Product/Model number Platform

1/1 Citrix ICA Client for DOS
E/1 Citrix ICA 32-bit Client for DOS
1/2 Citrix ICA Client for Win16
1/3 Citrix ICA Client for Win32
82/1 Citrix ICA Client for Macintosh

The version number is the release number of the Citrix ICA Client.

The process of updating Citrix ICA Clients with new versions uses the standard
ICA protocol.

“ The Citrix server queries the ICA Client when the user logs on. If the Citrix
server detects that the ICA Client is up-to-date, it continues the log on
transparently.

“ If an update is needed, by default, the Citrix server informs the user of the new
client and asks to perform the update. You can specify that the update occurs
without informing the user and without allowing the user to cancel the update.

“ By default, the user can choose to wait for the client files to finish
downloading or to download the files in the background and continue working.
Users connecting to the Citrix server with a modem get better performance
waiting for the client update to complete. You can force the client update to
complete before allowing the user to continue.

“ During the client update, new Citrix ICA Client files are copied to the ICA
Client device. The administrator can force the user to disconnect and complete
the update before continuing the session. The user must log on to the Citrix
server again to continue working.

“ After disconnecting from the server, the Citrix ICA Client completes the
update. All client programs must be closed before the Citrix ICA Client can be
updated.

“ If the user does not close all client programs before clicking OK, a message
appears informing the user of the open program. When all programs are closed,
the Citrix ICA Client can complete the update.

“ In case of a problem, the existing ICA Client files are saved to a folder called
Backup in the Citrix ICA Client directory.
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Configuring the Client Update Database
During Citrix server setup, a client update database is created that contains the
Citrix ICA Win32, Win16, and DOS Clients. By default, the update database is
configured to update older client versions.

You can configure a client update database on each Citrix server in a server farm,
or a single client update database on a central network share. With a single
database, you can configure updates once for all Citrix servers.

Use the ICA Client Update Configuration utility to:

“ Create a new client update database
“ Set a default client update database
“ Configure database properties
“ Add Citrix ICA Clients to the update database
“ Remove Citrix ICA Clients from the update database
“ Configure client update options

ùùùù To start the ICA Client Update Configuration utility
1. From a MetaFrame server: Click the Start button, point to Programs, and then

point to MetaFrame Tools. Click ICA Client Update Configuration.
From a WINFRAME server: In the Administrative Tools folder, double-click
ICA Client Update Configuration.

2. The ICA Client Update Configuration window appears:

The location of the current client update database is shown in the status bar.
This is the database the Citrix server uses to update Citrix ICA Clients. The
main window shows the ICA Clients currently configured in the database.
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Creating a New Client Update Database
The default location of the client update database is %SystemRoot%\Ica\Clientdb.
A new database can be created on the local server hard drive or on a shared
network drive. Multiple Citrix servers can be configured to use one shared client
update database.

ùùùù To create a new client update database
1. From the Database menu, click New. The Path for the new Client Update

Database dialog box appears:

2. Enter a path for the new client update database and click OK.
A new client update database is created in the specified folder and the new
database is opened.

Setting a Default Database
An existing client update database can be used by multiple Citrix servers. If the
client update database is on a shared network drive, use the ICA Client Update
Configuration utility to configure all Citrix servers to use the shared database.

ùùùù To specify a new default database for one or more Citrix servers
1. From the Database menu, click Open. The Open Existing Database dialog

box appears:
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2. Specify the path to the database that will be used as the default.
3. Click OK.
4. From the Database menu, click Set Default. The Set Default Database

dialog box appears:

Select the Set as Default Database on Local Machine check box to make the
currently opened database the default database.

You can also set other Citrix servers to use the currently open database as
the default database. Double-click on a domain name to view the servers in
that domain. Click on a server to set its default database to the currently open
database. You can select multiple servers by holding down the CTRL key.

5. Click OK.

Tip
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Configuring the Properties of the Client Update Database
Use the Database Properties dialog box to configure the current client update
database.

ùùùù To configure the properties of the Client Update Database
• On the Database menu, click Properties. The Database Properties dialog

box appears:

Clear the Enabled check box to disable this client update database. Citrix ICA
Clients are not updated if the database is not enabled.

The Default update properties for clients options specify the default behavior
for Citrix ICA Clients added to the update database. If you change the properties
of an individual client in the database, those properties will override the default
properties.

“ In Client Download Mode, click Ask user to allow the user to choose to
accept or postpone the client update. Click Notify user to notify the user of the
client update and require the update. Click Transparent to update the user’s
ICA Client without notifying the user.

“ In Version Checking, click Update older client versions only to update
client versions that are older than the new client. Click Update any client
version to update all client versions to this version of the client. Use this
option to force an older client to replace a newer client.
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“ In Update Mode, select the Force Disconnection check box to require users
to disconnect and complete the update. By default, users can choose whether to
disconnect and complete the client update after the new client files are
downloaded. Clear the Allow background download check box to force users
to wait for all client files to download before continuing. By default, users can
choose whether to download new client files in the background and continue
working.

“ Select the Log Downloaded Clients check box to write an event in the event
log when a Citrix ICA Client is updated.
By default, errors that occur during a client update are written to the event log.
Clear the Log Errors During Download check box to turn off error logging.

“ Specify the maximum number of simultaneous updates per Citrix server. When
the specified number of client updates are occurring, new client connections
are not updated. When the number of client updates drops below the specified
maximum, new client connections are updated.

Adding and Removing Citrix ICA Clients
Use the ICA Client Update Configuration utility to add Citrix ICA Clients to and
remove them from the database.

ùùùù To add a new Citrix ICA Client to the client update database
1. From the Client menu, click New. The Description dialog box appears:

Enter the path to the client installation file in Client Installation File or click
Browse.
The client installation file, Update.ini, is located in
%SystemRoot%\System32\Clients\Ica\ica32\disks\disk1.

2. After you specify the client installation file, the Client Name, Product,
Model, Version, and icon of the selected client appear.
You can also modify the Comment used for this client. After making any
changes, click Next to continue.

3. The Update Options dialog box appears.
The Update Options dialog box controls how the client update occurs. These
options for each client override the settings specified for the database as a
whole on the Database Properties dialog box.
In Client Download Mode, click Ask user to give the user the option to
accept or postpone the client update. Click Notify user to notify the user of the
client update and require the update. Click Transparent to update the user’s
ICA Client without notifying the user.
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In Version Checking, click Update older client versions only to update
client versions that are older than the new client. Click Update any client
version to update all client versions to this version of the client. Use this
option to force an older client to replace a newer client.
By default, users can choose to disconnect and complete the client update after
the new client files are downloaded. Select the Force Disconnection check
box to require users to disconnect and complete the update.
By default, users can choose to download new client files in the background
and continue working. Clear the Allow Background Download check box to
force users to wait for all client files to download before continuing.
You can optionally enter a message in Display this message on the user
terminal. The user can view this message at the start of the client update by
clicking More Info in the dialog box that appears.
Click Next to continue.

4. The Event Logging dialog box appears.
Auto Client Update uses the Windows NT event log to report status messages
and update errors.
“ Select the Log Downloaded Clients check box to write an event in the

event log when a Citrix ICA Client is updated.
“ By default, errors that occur during a client update are written to the event

log. Clear the Log Errors During Download check box to turn off error
logging.

Click Next to continue.
5. The Enable Client dialog box appears.

The client update database can contain multiple clients with the same product,
model, and version information. However, only one client of each product,
model, and version can be enabled. The enabled client is the one used for the
auto client update.
Select the Enable check box to update Citrix ICA Clients to this client. All
other clients of the same product, model, and version are disabled.

6. Click Finish to copy the Citrix ICA Client installation files into the client
update database.

ùùùù To remove a Citrix ICA Client from the database
1. In Client Update Configuration, click on the Citrix ICA Client to remove.
2. From the Client menu, click Delete. A dialog box displays the selected client

information and asks for confirmation.
3. Click OK to remove the client. The Citrix ICA Client is now removed from the

database.
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Changing the Properties of a Citrix ICA Client in the Database
Use the Properties dialog box to maintain the configuration of a Citrix ICA
Client in the client update database. The Properties dialog box contains four tabs:
the Description tab, the Update Options tab, the Event Log tab, and the Client
Files tab.

ùùùù To modify the properties of a Citrix ICA Client in the database
1. In ICA Client Update Configuration, click on the Citrix ICA Client to

modify.
2. From the Client menu, click Properties. The Properties dialog box appears.

“ The Description tab displays information about the selected client. The
Product, Model, Version, and Client Name are display-only fields.
Type a new description of the client in Comment.
Select the Enabled check box to update Citrix ICA Clients to this client.
All other clients of the same product, model, and version are disabled.
The client update database can contain multiple clients with the same
product, model, and version information. However, only one client of each
product, model, and version can be enabled. The enabled client is the one
used for the auto client update.

“ The Update Options tab configures how the client is updated.
In Client Download Mode, click Ask user to give the user the option to
accept or postpone the client update. Click Notify user to notify the user of
the client update and require the update. Click Transparent to update the
user’s ICA Client without notifying the user.
In Version Checking, click Update older client versions only to update
client versions that are older than the new client. Click Update any client
version with this client to update all client versions to this version of the
client. Use this option to force an older client to replace a newer client.
By default, users can choose whether to disconnect and complete the client
update after the new client files are downloaded. Select the Force
Disconnection check box to require users to disconnect and complete the
update.
By default, users can choose to whether to download new client files in the
background and continue working. Clear the Allow Background
Download check box to force users to wait for all client files to download
before continuing.
You can optionally enter a message in Display this message on the user
terminal. The user can view this message at the start of the client update by
clicking More Info in the dialog box that appears.
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“ The Event Logging tab configures the events to log for the client update.
Auto Client Update uses the Windows NT event log to report status
messages and update errors.
Select the Log Downloaded Clients check box to write an event in the
event log when a Citrix ICA Client is updated.
By default, errors that occur during a client update are written to the event
log. Clear the Log Errors During Download check box to turn off error
logging.

“ The Client Files tab displays the individual files for the ICA Client.

The client update database stores the File Name, Group, Flags, FileSize, and File
CRC for each file of a Citrix ICA Client.
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C H A P T E R  3

Overview
This chapter describes how to configure the ICA Macintosh Client. Topics in this
chapter include:

“ Starting the ICA Client Editor
“ Creating a connection file
“ Configuring default settings

“ Configuring default preferences
“ Configuring default window settings

“ Mapping client devices
“ Mapping client drives
“ Mapping client printers
“ Mapping client COM ports

“ Using a SOCKS proxy server

Configuring the Citrix ICA
Macintosh Client
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Starting the ICA Client Editor
Use the ICA Client Editor to create and edit connection files. Connection files
contain configuration options that define the attributes of the ICA sessions you run
on Citrix servers. These attributes include window size and color, initial
application and working directory, and client drive and printer mapping
preferences. Connection files appear as icons on the Macintosh desktop or in a
specified folder.

ùùùù To start the ICA Client Editor
• Double-click the Citrix ICA Client Editor icon in your ICA Macintosh Client

installation directory.

Creating a Connection File
The ICA Macintosh Client can connect to both servers and published applications.
The first thing you must specify in the connection file is the server or published
application to which to connect. The following procedure describes how to create
a basic connection file. See the following sections for advanced configuration
settings.

ùùùù To create a connection file
1. In your installation folder, double-click Citrix ICA Client Editor. The Citrix

ICA Client Editor dialog box appears with the Network Connection page
selected:
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2. Click Server to connect to a server or Published Application to connect to a
published application.

3. In the Server box, type the name or IP address of the Citrix server or the name
of a published application. If server browsing is possible, you can click the
button to the right of the Server box and select the name from the list.

4. To log onto the Citrix server automatically, enter your user name, password,
and domain in the appropriate boxes. If you leave these boxes blank, the Citrix
server prompts for this information each time you make a connection.

5. Click Save. Select a location in which to save the file. By default, the Save
connection as box displays the Citrix server or published application name.
You can also click Connect to start the ICA session immediately. If Quit after
connect is selected, the ICA Client Editor exits when the connection is made.
A dialog box appears allowing you to save the connection file.

6. Click Quit to exit the ICA Client Editor.

Configuring Default Settings
The Citrix ICA Client Editor Default Settings dialog box allows you to specify
the default settings used for all ICA connections. The settings you make in this
dialog box are applied to all connection files. Some settings can be overriden for a
specific connection file using the appropriate page of the ICA Client Editor
dialog box.

ùùùù To configure default settings
• From the Options menu, select Default settings. The Citrix ICA Client

Editor Default Settings dialog box appears.
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The Citrix ICA Client Editor Default Settings dialog box contains the
following pages:

Page Description

Window Default size and color depth to use for ICA session
windows

Preferences Options for playing Windows alert sounds,
automatically quitting the ICA Client after the ICA
session ends, and automatic client update

Printer Setup Settings for client printer mapping 1

Drive Mapping Settings for client drive mapping 1

Disk Cache Settings for persistent bitmap cache
Server Location Settings for Business Recovery, SOCKS proxy

configuration 2, and alternate address remapping
Com Port Mapping Settings for client COM port mapping 1

1 Client device mapping is described in “Mapping Client Devices” later in this chapter.
2 SOCKS proxy configuration is described in “Using a SOCKS Proxy Server” later in this chapter.



Chapter 3    Configuring the Citrix ICA Macintosh Client   21

Configuring Default Window Settings

In this window, you can select one of four predefined windows sizes, enter a
custom size up to 2048 x 2048 pixels, or use the full screen.

You can also set the number of colors to 16 or 256. For optimum performance, the
number of colors should match the setting in your Macintosh Monitors control
page.

These settings are used as the default for connection files with Use Default
selected.

Configuring Default Preferences

Select Enable Windows Alert Sounds to play the default Macintosh beep when
an application in the ICA session triggers the default Windows beep.
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Select Enable ICA Client Auto Quit to exit the ICA Client automatically when
you close a connection.

Select Allow Automatic Client Updates to allow the Citrix server to update the
Citrix ICA Macintosh Client when newer versions become available. When the
Citrix server detects an outdated client version, it notifies the user that a newer
version is available and replaces the ICA Macintosh Client files.

Configuring the Disk Cache
The Macintosh ICA Client stores commonly-used graphical objects such as
bitmaps in a local cache on the client computer’s hard disk. You can configure the
following settings from the Disk Cache page of the Default Settings dialog box:

Setting Description

Amount of disk space
to use

The amount of disk space to use for the cache as a percentage of
the total size of the disk containing the cache folder.

Disk cache folder The default directory where the cached data is stored is
displayed in this box. Click Change Folder to specify a new
directory for cached data.

Minimum size bitmap
to be cached

The size of the smallest bitmap to be cached to disk.

Click Clear Disk Cache Now to remove all cached data from the client computer.

Although you can configure the default disk cache settings, disk caching is
not used unless you enable it for a particular connection file. Disk caching for
individual connection files is enabled on the Connection Properties page of the
ICA Client Editor dialog box.

Note
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Configuring Business Recovery
This feature provides consistent connections to published applications in the event
of a master ICA Browser server disruption. You can define up to three groups of
Citrix servers to which you want to connect: a primary and two backups. Each
group can contain up to five servers. When you configure Business Recovery, the
client attempts to contact all the servers within the Primary group simultaneously
(broadcasting); the first server to respond acts as the master ICA Browser. If none
of the servers respond, the client attempts to contact all the servers within the
Backup 1 group. If there is still no response, the client attempts to contact all of
the servers in the Backup 2 group. When a server responds, the client queries the
server for the address of the server on which to run the published application. This
process is repeated each time the user attempts to make an ICA connection.

ùùùù To configure Business Recovery server groups
1. If the Citrix ICA Client Editor Default Settings dialog box is not displayed,

from the Options menu, select Default Settings.
2. From the pop-up list at the top of the Default Settings dialog box, select the

Server Location page.
3. From the Server Group list, select the server group you want to configure.
4. Click Add to add a server to the selected group.
5. In the Server box, type or select the name of the server, then click OK.
6. Add more servers as necessary and then click Save to save the new settings.

If the ICA Client is outside a firewall that uses address remapping, you configure
the ICA Client to use the alternate address returned by the master ICA Browser.
This is necessary even if you are not using a SOCKS proxy server.

You must also use the ALTADDR utility to manually set the alternate
address for each Citrix server. See the Command Reference appendix of either the
MetaFrame Administrator’s Guide or the WINFRAME System Guide for more
information.

Note
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ùùùù To configure the ICA Macintosh Client to use the alternate address
1. If the Citrix ICA Client Editor Default Settings dialog box is not displayed,

from the Options menu, select Default Settings.
2. From the pop-up list at the top of the Default Settings dialog box, select the

Server Location page.
3. Click Firewalls. A pop-up dialog box appears.
4. Click Use alternate address for firewall connection and then click OK to

close the pop-up dialog box.
5. In the Default Settings dialog box, click Save to save the new settings.

Advanced Connection File Settings
This section contains advanced configuration settings for the ICA Macintosh
Client. These options can be set when creating a new connection file or you can
edit an existing connection file.

ùùùù To edit an existing connection file
1. From within the Citrix ICA Client Editor, choose Open from the File menu

and select the connection file you want to edit.
— or —
From the desktop, drag the connection file and drop it onto the Citrix ICA
Client Editor icon.

2. The Citrix ICA Client Editor dialog box appears, showing the current
properties of the connection file.

3. Edit the properties you want to change and then click Save to save the
connection file, or choose Save from the File menu.

The following topics describe the additional properties and settings you can
configure using the ICA Client Editor:

“ Connection properties
“ Window properties
“ Application properties
“ SOCKS proxy server
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Configuring Connection Properties
You can configure existing connection files using the Properties dialog box.

ùùùù To configure connection properties
• Select Connection Properties from the pop-up list in the ICA Client Editor

dialog box.

The Connection Properties page has the following options:

“ Use Data Compression. Check this box to enable data compression. Data
compression reduces the amount of data sent over the connection but
consumes a small amount of processor time to perform the compression and
decompression. In high-bandwidth LAN environments where bandwidth
consumption is not a concern, disabling data compression may give better
performance.

“ Use Disk Cache For Bitmaps. Check this box to enable persistent bitmap
caching. The client stores cached bitmaps in a local directory to reduce the
amount of data sent over the connection. Because the cached bitmaps are
stored on hard disk, commonly used bitmaps can be displayed more quickly.

“ Enable Sound. Check this box to enable full sound support. All audio played
in the ICA session is sent over the ICA connection and played on the client
computer.

“ Quality. This option allows you to configure the sound quality. Select one of
the following values:
“ High. This value provides the greatest audio quality but should only be

used when bandwidth consumption is not a concern.
“ Medium. Using this value results in less bandwidth consumption than

when using High. Compression of sound data provides greater bandwidth
efficiency but reduces sound quality somewhat. This value is recommended
for most LAN-based connections.

“ Low. This value offers the most efficient use of bandwidth but also
decreases sound quality severely. This value is recommended for low-
bandwidth connections, including most modem connections.

“ Disable local printer for connection to this server. Check this box to disable
local printing for connections to this server or published application.

“ Disable drive mapping for connection to this server. Check this box to
disable drive mapping for connections to this server or published application.
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Configuring Window Properties
The Window page allows you to specify the window size and number of colors
used for the ICA Client window.

ùùùù To configure window properties
• Select Window from the pop-up list in the ICA Client Editor dialog box.

Select Use Default to use the default window size or window colors setting
specified with the Default Settings... command on the Options menu. For
more information, see “Configuring Default Settings” later in this chapter.

Window Size allows you to select one of four standard window sizes.
Alternatively click Custom to enter a custom size up to 2048 x 2048 pixels or Use
Full Screen to use the full screen. If you select Use Full Screen, the menu bar
will be hidden when you run the ICA Client. To access the Macintosh menu bar,
hold down the Option and Control keys. To make the menu bar display
permanently, open the File menu in the ICA Client and choose Best.

Window Colors allows you to set the number of window colors to 16 or 256.

For best performance, Windows Colors should match the number of colors
set in your Macintosh Monitors control panel.

Configuring Application Properties
The Application page allows you to specify the path and file name of an
application to be executed after connecting to a Citrix server. The connection is
closed when you exit from the application.

If an application is specified, no other application can be run in the ICA session.
You are not able to use Program Manager on WINFRAME or the Windows desktop
on MetaFrame.

The Application dialog box is not available when configuring a connection
to a published application.

ùùùù To configure application properties
1. Select Application from the pop-up list in the ICA Client Editor dialog box.
2. Specify the path and file name of the application to be executed after

connecting to the Citrix server.
For example, to launch Microsoft Word automatically after connecting to the
Citrix server you might type:
C:\WINWORD\WINWORD.EXE

Note

Note
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3. Specify the working directory to be used with the application in the Working
Directory box.

Mapping Client Devices
The Citrix ICA Clients support client device mapping. Client device mapping
allows a remote application running on the Citrix server to access printers, disk
drives, and COM ports attached to the local client computer.

Mapping Client Drives
Client drive mapping allows you to access the local disk drives of the client
computer from ICA sessions. When both the Citrix server and ICA Client are
configured to allow client drive mapping, you can access locally stored files, work
with them from ICA sessions, and then save them either on a local drive or on a
drive on the Citrix server.

The Drive Mapping list shows which Macintosh local disks and folders will be
used with your Citrix server sessions and allows you to change their settings.

Drives A:, B:, and C: are permanently mapped to the Macintosh floppy disk drive,
the Macintosh CD-ROM drive (if available), and the Macintosh hard disk.
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ùùùù To map a folder on the Macintosh hard disk to your ICA session
1. In the ICA Client Editor Options menu, select Default Settings. In the Citrix

ICA Client Editor Default Settings dialog box, select Drive Mapping from
the pull-down menu.
For each server drive letter, the Drive Mapping list shows the disk or path
name of the Macintosh folder mapped to the drive. In the Enabled/read/write
column, icons display whether each mapped drive is enabled for use and what
type of access you have to the drive. Items you cannot change (such as your
hard drive) are grayed out. Items that are no longer available are in italics.

2. Select an available drive letter. For example, in the dialog box shown above,
you might select D:.

3. Click Modify. Select the folder on the Macintosh hard disk to map and click
the Select bar. The mapped folder appears in the Drive Mapping list. If the
drive letter you selected is not available on the Citrix server, the specified
folder is mapped to another free drive letter.

4. Click Save. Log off any ICA connections already established and reconnect.

ùùùù To view mapped client drives when connected to a MetaFrame server
• From within the ICA session, double-click My Computer on the desktop. The

My Computer window appears:

In this example, drives C, D, and E are storage devices on the MetaFrame
server. The Macintosh floppy disk drive and Macintosh hard disk on the client
computer are mapped to drives A and V on the MetaFrame server,
respectively. You can access the Macintosh hard disk in this ICA session by
using drive V for any operation. For example, to save a file to the client
machine’s hard disk, specify drive V in the application.
Citrix servers can be configured to remap their server drives. When server
drives are remapped, the local drives take drive letters different from those in
the example above.



Chapter 3    Configuring the Citrix ICA Macintosh Client   29

Published applications and Citrix server connections that have an initial program
configured offer you the same access to your local drives. When connected to
published applications, a user can access local drives in the same way as when
using applications running locally.

Mapping Client Printers
Client printer mapping lets you access printers attached to your client computer
from an ICA session. When a Citrix server is configured to allow client printer
mapping, applications running remotely on the Citrix server can print to local
printers. With the ICA Macintosh Client, you can print to a PostScript printer or to
a PC printer connected to the Macintosh serial port. You can disable printing for
individual connection files in the Connection Properties page of the ICA Client
Editor dialog box.

Printing to a PC printer requires the PowerPrint package from Infowave
Wireless Messaging Inc. (http://www.infowave.com).

After configuring printer mapping, you must log off and then reconnect any active
ICA sessions for the changes to take effect. Changes made to your printer
mapping configuration apply to all connection files.

ùùùù To configure a local printer for client printer mapping
You can redirect printing to a PC printer using an appropriate Macintosh printer
driver selected in the Macintosh Chooser.
1. If necessary, install the appropriate printer driver on your Macintosh and select

it in the Macintosh Chooser.

Note
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2. Using SimpleText or any other suitable application, verify that you can print to
the printer from your Macintosh.

3. Run the Citrix ICA Client Editor.
4. From the ICA Client Editor Options menu, select Default Settings.
5. In the Citrix ICA Client Editor Default Settings dialog box, select Printer

Setup from the pull-down menu. The Printer Setup screen appears.
6. In the Local Printer Type box, select PostScript Printer to map a local

PostScript printer or Direct Printer to map a local PC printer. To disable
printing for all ICA sessions, select None.

7. Select your printer from the list. If it is not listed, click Add... and type the
name exactly as it appears in the Citrix server’s list of printer drivers. Click
OK to return to the Default Settings dialog box.
To see a list of printer drivers on a Citrix server, first connect to the Citrix
server using the ICA Client. On a WINFRAME server, start Print Manager and
run the Create Printer wizard. The driver list contains printer names as they
should be specified. On a MetaFrame server, click Printers in Control Panel.
Start the Add Printer wizard and continue through its screens until you reach
the screen that contains the list of printers by manufacturer.

8. Click Save.

ùùùù To view mapped client printers when connected to a MetaFrame server
• While connected to a MetaFrame server, double-click My Computer on the

remote desktop and then double-click Printers. The Printers screen appears:

The Printers screen displays the mapped local printers along with any other
printers available on the MetaFrame server. The name of the printer is
macintosh name#Mac Printer, where macintosh name is the Macintosh
Name in the Macintosh Sharing Setup or File Sharing control panel. In this
example, the  Macintosh client machine named Workstation3 has its local
printer mapped.
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ùùùù To view mapped client printers when connected to a WINFRAME server
• While connected to the WINFRAME server, double-click Print Manager in the

Main program group of Program Manager. Print Manager displays the local
printers mapped to the ICA session.
The name of the printer is macintosh name#Mac Printer, where macintosh
name is the Macintosh Name in the Macintosh Sharing Setup or File
Sharing control panel.

If your client printer is not automatically mapped on the Citrix server, you can
manually map it in the ICA session. Use the following procedures to manually
map a client printer.

ùùùù To manually map a client printer on a MetaFrame server
1. Log on to the MetaFrame server.
2. In the ICA session window, double-click My Computer and then double-click

Printers.
3. Double-click Add Printer. Select Network printer server and click Next.
4. In the Shared Printers field, double-click Client Network and then double-

click Client.
5. Select macintosh name#Mac Printer, where macintosh name is the

Macintosh Name in the Macintosh Sharing Setup or File Sharing control
panel and then click OK.

6. If you want this printer to be your default printer, click Yes.
7. Click Next and then click Finish.

ùùùù To manually map a client printer on a WINFRAME server
1. Logon to the WINFRAME server.
2. In the ICA session window, double-click Print Manager in the Main program

group of Program Manager.
3. From the Printer menu, click Connect to Printer.
4. In the Shared Printer list, double-click Client Network and then double-click

Client.
5. Select macintosh name#Mac Printer, where macintosh name is the

Macintosh Name in the Macintosh Sharing Setup or File Sharing control
panel and then click OK.

6. If you want this printer to be your default printer, select it in the Default menu
near the top of the Printers window.
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Mapping Client COM Ports
Client COM port mapping is similar to printer and drive mapping. It allows users
to access serial devices on the client computer as if they were connected to the
Citrix server.

ùùùù To map a client COM port
1. If the Citrix ICA Client Editor Default Settings dialog box is not displayed,

from the Options menu, select Default Settings.
2. From the pop-up list at the top of the Default Settings dialog box, select the

Com Port Mapping page.
3. From the Com Port Mapping list, select the COM port you want to configure.

This is a virtual client COM port that appears in the ICA session. It does not
refer to an actual port on either the client or server computers.

4. Click Modify to map a local port to the selected COM port. A dialog box
appears.

5. Select the actual physical port to associate with the selected COM port and
click OK.

6. Map other ports as necessary and then click Save to save the new settings.

ùùùù To use a mapped client COM port from within an ICA session
1. Start the ICA Client and log on to a Citrix server.
2. Start a command prompt: on WINFRAME, double-click Command Prompt in

the Main program group. On MetaFrame, click Start, then click Programs,
then click Command Prompt.

3. At the prompt, type net use comx: \\client\comz: where x is the number of the
COM port on the server (ports 1 through 9 are available for mapping) and z is
the number of the client COM port you want to map.

4. To confirm the operation, type net use at the prompt. The list that appears
contains mapped drives, LPT ports, and mapped COM ports.

5. Use this mapped COM port as you would a COM port on the Citrix server.

COM port mapping is not TAPI-compatible. Applications that communicate
with devices using TAPI are not supported.
Note
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Using a SOCKS Proxy Server
If you are using a SOCKS proxy server to limit access to your Citrix servers, you
must configure the ICA Macintosh Client to connect to Citrix servers through a
SOCKS proxy server. You can configure a default SOCKS proxy for all
connections or only use a SOCKS proxy with a specific connection file.

ùùùù To configure a default SOCKS proxy server
1. If the Citrix ICA Client Editor Default Settings dialog box is not displayed,

from the Options menu, select Default Settings.
2. From the pop-up list at the top of the Default Settings dialog box, select the

Server Location page.
3. Click Firewalls...
4. Click Connect via SOCKS proxy.
5. In the Address of proxy to use box, enter the SOCKS proxy server’s IP

address.
6. In the Port box, enter the proxy server’s port number (if different than 1080).
7. Click OK to close the pop-up dialog box, and then click Save to close the

Default Settings dialog box.

Because you can enter only one SOCKS proxy server address, you cannot
configure Business Recovery with separate SOCKS settings for different server
groups.

ùùùù To configure a SOCKS proxy server for a specific connection file
1. From within the Citrix ICA Client Editor, choose Open from the File menu

and select the connection file you want to edit.
— or —
From the desktop, drag the connection file and drop it onto the Citrix ICA
Client Editor icon.

2. The Citrix ICA Client Editor dialog box appears, showing the current
properties of the connection file.

3. From the pop-up list at the top of the ICA Client Editor dialog box, select the
SOCKS Configuration page.

4. Click Connect via SOCKS proxy.
5. In the Address of proxy to use box, enter the SOCKS proxy server’s IP

address.
6. In the Port box, enter the proxy server’s port number (if different than 1080).
7. Click Save to save the changes to the connection file.

Note
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